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You Design It
   We Print It

My Fabric

DESIGNS

You Design It
   We Print It

When it comes to creating a quilt or other fabric project you can’t beat the personal touch using custom fabric 
offers. Sure you can go into a store or online and choose fabric, but if you want to make something no one else 
has then custom print-on-demand fabric is for you. 

We offer easy-to-use online tools to help you design your own seamless repeating pattern. Add personalization 
to photos or other graphics for one-of-a-kind quilts, pillows, tea towels and more. Not a designer? No 
worries you can also choose a finished design from our online artist collection. Choose from any of our 29 
high-quality fabrics that rival traditionally milled and printed fabrics and get exactly the look you want.

Order as little as a yard and we’ll print and deliver your fabric right to your doorstep!

Take 20% off - use code: 20custom
expires 10/31/19

z

Visit us online at MyFabricDesigns.com
custom fabrics shown by: friztin
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Preserve your memories the moment they happen.
CAPTURE THE MOMENT

husqvarnaviking.com
VIKING and MYSEWNET are trademarks of KSIN Luxembourg II, S.a.r.l. 
HUSQVARNA and the “H” Crown Device are trademarks of Husqvarna AB and 
are used under license.  © 2019 KSIN Luxembourg II, S.a.r.l.  All rights reserved.
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swpea.com

Machine Embroidery Designs
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The perfect course for anyone new to  “In the Hoop” machine embroidery.
The course includes a variety of projects which will progressively get more advanced as the 
you proceed. Through the course you will acquire a wide range of skills and produce 12 beautiful 
embroidery projects. We recommend this course for beginners, but everyone is welcome to join. 
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Elegant Mirrors

They stitch perfectly in your hoop

and Makeup Brush Case

Fun, creative In the Hoop
machine embroidery designs
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Happy Stitching!

Eileen Roche,
Embroidery Expert & 
Editor of Designs in Machine Embroidery

"Pull Quote"

Between 
Friends

www.dzgns.com/blog/

VisitEileen’s Blog for more fun from Behind the Scenes
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YOUR ONE-STOP-SHOP FOR ALL THINGS EMBROIDERY

Designs Pictured: Rosemaling Blooms (DC01-WC0431), Rosemaling Corner (DC01-WC0437),  
and Rosemaling Flower (DC01-WC0428).

Smart
Style Secret

Bring old pieces back 
to life instantly with a 
touch of embroidery.
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What's New In Designs
By Rebekah Brown
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What's New In Designs

dime_Volume_117_Body.indd   9 5/15/19   1:26 PM



Designs in Machine Embroidery • Volume 117 • July/August 2019 • www.dzgns.com10

dime_Volume_117_Body.indd   10 5/15/19   1:27 PM



Designs in Machine Embroidery • Volume 117 • July/August 2019 • www.dzgns.com 11

If you have seen some of my other projects, you know 
that I am quite fond of vintage linens. Nothing today 
can compare to the feel of an heirloom fabric. There is 
just something about the history and nostalgia that they 
hold. These thrift shop and flea market rescues provide 
project potential with plenty of personality.

Embroidery Products
Flower outline from Button Bloom Birdhouse 

available at EmbroideryOnline.com
Bickham Floss Font from JolsonsDesigns.com
Design editing software (Embrilliance)

Materials
Vintage tablecloth
½ yd. bodice lining fabric
½ yd. woven fusible interfacing (Pellon SF101 

ShapeFlex)
Vintage buttons
Barclay Vintage Apron pattern from Ruby Jean’s 

Closet, etsy.com/shop/rubyjeanscloset

Supplies
Water soluble mesh stabilizer
Temporary spray adhesive
Size 70/10 embroidery needle
Mary Ellen’s Best Press
40 wt. embroidery thread
Cotton sewing thread

At the Computer

Open the birdhouse embroidery in design editing 
software. Eliminate everything except the large pink 
flower head. Center it in the hoop and save it as 
"Center Medallion".

An Apron for Ellie
        By Debbie Henry
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In design editing software, load the Bickham Floss 
Font. I chose this particular font because it resembled 
traditional backstitch hand embroidery. Create the 
"Ellie" file (see sidebar).

Preparing Pattern Pieces

The Barclay pattern is a vintage re-creation for 
children’s sizes from 2 to 8.

I chose a handkerchief linen tablecloth for my primary 
fabric and a coordinating print for the bib lining and 
ties.

Print out the pattern pieces and assemble them as 
directed, using cutting lines for the size desired. Be 
sure to print the pattern PDF at 100 percent (actual 
size). Trim along outside lines.
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Preparing the Vintage Tablecloth
Depending upon how they are stored, vintage linens 
may require washing before use. If not, starched cloth 
is a dream to sew and embroider. Either way, press well 
before cutting out pattern pieces.

Debbie's Tip:
Wetting starched linens, to remove marking pens 
or water soluble stabilizer, sometimes results in a 
water mark. If that happens, hand-wash the piece 
in a gentle soap. Rinse well, roll up in a towel to 
eliminate most of the moisture, and let it dry flat. 
When dry, iron using starch or a starch substitute.

Cutting the Bodice

Position the Apron Bib pattern on the tablecloth in 
such a way as to take advantage of any unique features, 
like designs, borders, or stripes. Because this tablecloth 
was round, it did provide the unique challenge of 
not having perfectly straight borders. Special care 
was necessary to ensure that the curved border was 
centered correctly on apron pieces.

For pattern pieces cut on a fold, stripes and borders 
of the linen should overlap each other and should be 
pinned in place to prevent shifting. Measurements 
from identical landmarks on the bib front should be 
the same. That way, you are left with a definite center 
point and designs are symmetrical when pieces are cut 
out.

Because the handkerchief linen is rather delicate, I 
fused a piece of SF101 to the back of the cut bib and 
trimmed around the edges. Cut a duplicate piece of the 
Apron Bib pattern on a coordinating fabric to use as a 
lining.
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Cutting the Skirt

I took full advantage of the tablecloth’s rolled hem 
edge and used it for the bottom of the apron skirt. (No 
additional hemming makes me happy.)

As with the bodice, keep borders of the tablecloth 
placed perfectly on top of each other when cutting out 
the skirt on a fold. Because the bottom hem is also 
rounded and the skirt pattern is rather square, place 
the pattern so that the distance from the edge of the 
top border to the waist edge of the skirt measure the 
same.

Assembling the Apron
Stitch waist ties, neck ties, and the Apron Bib together 
as directed. Hem the sides of the skirt. Attach the bib 
to the skirt.

The top scalloped edge of the bib flips to the front of 
the apron to expose the coordinating fabric. Fold it 
over and pin it in place.

Load the Center Medallion embroidery design and 
hoop water soluble stabilizer. Position the folded bib in 
the hoop and stitch the medallion design in the center 
of the flap. I chose a gold thread color that was very 
subtle so as not to distract from the metallic gold in 
the lining fabric. The embroidery serves as much to 
tack down the bib fold as it does to accent the apron.

Vintage buttons were added to each scallop of the bib.

In keeping with the vintage theme, I embroidered the 
name "Ellie" along the lower left edge of the skirt. 
Water soluble stabilizer was again used due to the 
delicate nature of the linen. In retrospect, I probably 
could have used a light tear-away stabilizer since the 
font was triple stitched.
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Debbie's Tip:
As I was creating this project, I had all kinds of 
ideas for adding embroidery, ric rac, lace, pockets. 
When it was stitched together, the fabric was so 
beautiful, I felt that adding anything more would 
take away from the apron rather than improve it.

Font Adjustment
Embroidery editing software, like Embrilliance, makes 
font placement so much easier.

While standard fonts must be placed one letter at 
a time and manually aligned, BX fonts work more 
like a keyboard font and arrange letters just as if you 
are typing an email. Some adjustments may still be 
necessary with BX, especially when using script-type 
fonts that mimic handwriting.

When first typed, this font’s spacing needed 
tightening.

Adjusting the spacing worked well for the two Ls but 
still was not quite right for the rest of the letters.

Again, using BX fonts, I created a file by placing the 
capital E, two Ls, and the IE as separate pieces. That 
way, I could adjust each set individually without 
having to move all five letters.

Use a line on the screen grid and place the two Ls. 
Move the I and E closer together and line them up 
with the Ls. Finally, drop the capital E a bit so that it 
attaches perfectly to the rest of the letters. Color sort, 
center in the hoop, and save the file.
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IQ, 
do 
you?

By 
Katherine 
Artines
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Embroidery Products
Baby Lock Solaris Sewing and 

Embroidery Machine with IQ 
Designer technology

Supplies
Metal pendants: rectangle, 1" x 2"; 

round, 1 ½" diameter
Piece & Stitch tear-away stabilizer
Assortment of background fabrics
Threads: variety of embroidery 

threads, metallic threads, 
embroidery bobbin thread

Double-sided peel-and-stick tape 
or choice of glue

Optional: beads, vinyl cut-outs, 
water soluble film topper

Measure the metal pendants. 
You’ll need an exact measurement 
of the flat area where the 
embroidered fabric will lay. The 
design measurement will be 
slightly smaller than the pendant 
area, as there will be a bit of fabric 
that extends beyond the stitched 
outline, all of which needs to fit 
within the pendant and lay flat.  
The longer pendant measures 1" 
x 1 15/16" (1.9375). The design was 
created at .90" x 1.89". The circle 
pendant is 1.5" wide and the design 
was created at 1.35".

The pendants showcase the 
negative of an initial; that is, there 
is no stitching of the letter, just the 
outline is stitched.

On the home screen of your 
machine, touch Embroidery / 
touch the Text button / choose a 
font that is thick, such as 03 or 16. 
Type the desired letter in either 
uppercase or lowercase. Leave it 

Large, touch Set. In Embroidery 
Edit, touch Edit / Embroidery 
Pattern Outline key.

This key extracts the outline of a 
pattern which can then be used in 
IQ Designer. Leave Distance = 0" 
/ touch Memory / OK. Clear the 
letter from the screen.

Touch IQ / touch Stamps (Shapes).

Touch the Square / OK / Size / set 
to 1.89" high x .90" wide / OK.  
Touch Memory key / Machine 
Pocket - you now have the shape 
of the pendant to use with other 
letters.

Touch Stamps (Shapes) / 
Embroidery Pattern Outline at top.

Touch the Letter Design / OK.  
With it selected, touch Size and 
use the sizing keys to size the 
letter to fit within the rectangle, 
leaving enough room between the 
rectangle and letter to show the 
decorative fill (Zoom if necessary) 
/ use the Move keys if necessary / 
OK.

If you have a letter with an inside 
"hole," you’ll need to add that, as 
the Embroidery Pattern Outline 
only extracts the outside line. The 
inside of this lowercase "d" was 
created by adding a Stamp / Circle, 
which was sized individually by 
height and width to give it the 
necessary shape.

Touch Line Properties / touch 
Running Stitch.   
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Touch Blue / OK / touch Line Pour.  Touch Rectangle 
and Letter Outline on screen (they should turn blue).

Touch Region (Fill) Properties / touch the Decorative 
Fills button.

    

Make your selection, OK /  touch Green / OK.

Touch Region (Fill) Pour / touch area to fill between 
the letter shape and the rectangle. 

Change the size for the Decorative Fill to the smallest 
50%, leaving the remaining default settings for the 
individual stitch settings / Set / OK to bring the design 
into Embroidery Edit. Touch Memory / Machine 
Pocket. Touch Embroidery if you are ready to stitch 
this design. 

To create the round pendant design, you would follow 
the previous steps with these differences: create the 
Embroidery Pattern Outline for the next letter in 
the chosen font. Choose the circle shape and size it 
proportionately to 1.35".  

Save each pendant design to Memory so they are 
available to bring in to a 4" x 4" hoop.
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The Embroidery Process
Four of these pendants could be stitched in a 4" x 4" 
hoop. 

Prepare the hoop with firm tear-away stabilizer only. 
Cut background fabric pieces for each pendant, larger 
than the design size. For example, the rectangle piece 
was cut at 2 ½" x 1 ½"; the circle, 2 1/4". Lay the fabric 
down for the first design. Use the camera to see if the 
placement is correct.   

Stitch the design.  Trim away the excess fabric about 
½" away so that it is not extending into the design area 
of the next pendant. If you prefer, you certainly could 
stitch one pendant at a time or hoop background 
fabric with stabilizer in the 4" x 4" hoop, with each 
pendant having the same background fabric.

When embroidery is complete, trim a scant 1/8" away 
from the stitched pendant outline. Sew on any desired 
embellishments. Use double-sided peel and stick tape 
on the back of the trimmed design, or your choice of 
glue, to adhere the embroidery design to the metal 
pendant.

Challenge completed! Whether you create these fabric 
pendants at your embroidery machine or in your 
software, they make a fast and fabulous gift.
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Repurpose 
                                  

           for        

                                R
over!

By Colleen Bell
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Recycling or repurposing a garment can reduce landfill 
waste as well as bring satisfaction of utilizing a well-
loved item. "Landfills received 10.5 million tons of 
MSW [Municipal Solid Waste] textiles in 2015. This 
was 7.6% of all MSW landfilled.*" That is an incredible 
amount of textiles that could be recycled.

Here is a project for your best friend, aka, your dog. 
You can use an old sweatshirt, or any large garment, to 
be sewn into a dog coat. Do you have an old raincoat 
that you no longer use? Perfect for a new raincoat for 
Rover. Use what you have instead of discarding it. We 
can reduce that landfill one garment at a time. Make 
the next dog coat a quilted one and spray it with 
a water repellent. Whatever you choose, have fun 
creating, and reducing at the same time!

Embroidery Products
Canine Couture Design Pack (Medium UT7859),  

from urbanthreads.com
Dream Weave Fusible® Stabilizer
Snap Hoop Monster by dime

Material
½ yd. sweatshirt fabric or a used garment

Pattern
Dog Coat Pattern Top and Bottom  

at www.dzgns/magazine/CurrentIssue/Vol117

Notions
Self-adhesive Velcro Dots
General sewing supplies

Step 1.  At the Computer
At the computer, download the embroidery design file 
and transfer it to the embroidery machine.

Download and print the two dog coat patterns 
(top and bottom) from www.dzgns/magazine/
CurrentIssue/Vol117.

Colleen’s Tip
The pattern is designed for a small dog about
15 – 20 pounds. Measure the pattern for your dog 
and enlarge or reduce it accordingly. It is a simple 
design so there are no complicated calculations 
needed to make adjustment.

Step 2. Preparation
Wash and press the fabric or the repurposed garment. 
If using a garment, decide the best placement of the 
pattern and adjust for any defects in the garment.

Cut the printed pattern along the solid lines. Align and 
overlap the A and B sections and tape together.

Place the pattern on the garment and cut two pieces of 
the coat body.

* www.epa.gov
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Cut four rectangles from the garment measuring  
7" x 2 ½" (adjust as necessary).

Following the manufacturer’s guidelines, fuse the 
stabilizer to the back of one coat body.

Step 3. Embroidery
Hoop the fused coat body in the Snap Hoop Monster, 
centering it as desired.

Embroider the design following Urban Threads’ color 
sequence.

Trim the threads and remove from the hoop. Trim the 
stabilizer close to the design.

Step 4. Construction
This project assumes a general knowledge of sewing 
skills. The pattern includes a 1/4" seam allowance. 
Please use standard sewing procedures such as 
pressing, clipping curves, and trimming corners.

Colleen’s Tip
Sweatshirts are made from a knit fabric. For this 
dog coat pattern, a special knit stitch or serger is 
not necessary. However, caution should be taken 
when sewing it together that it does not stretch. 
Pin generously to prevent stretching.

Pin the two rectangles right sides together and sew along 
three edges, leaving one short end open. Turn right side 
out and press. Topstitch. Do this for the remaining two 
rectangles.

Place the raw/open edge of the rectangles along each 
side of the body of the coat. Center it as desired (where 
it would be best for your dog). Baste the straps in place.

Place the two body pieces together with right sides 
together, and sew along the edges. Leave about 2" open 
on the end. Turn right side out and press. Topstitch. 
It is not necessary to sew the opening closed. The 
topstitching will close it sufficiently.

Add the Velcro dots to the neck and the straps. Stitch 
in place to secure.

Hugs for Rover!
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Monogram Designs for Embroidery Machines Since 1996
www.embroideryarts.com

Take quilts from Start to Finish

Custom Quilting 
on Your Embroidery Machine

Our new book features:
•  Patterns for 4 quilts & 
    2 table runners
•  Traditional and contemporary 
   quilting designs (with feathers!)
•  Complementary border designs
•  Instructions and tips for 
    custom quilting

Available at your local quilt store 
and www.ameliescott.com. 

Web special: use coupon code 
Bahama for 10% off!
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Favorite pair 
         ofJeans!
             By Melissa Booritch

What do you do when you get a hole 
in your favorite jeans? Are they ruined 
forever? Is it time to say good-bye to 
the jeans? I say, no! You can use that 
unfortunate hole and patch it with a 
beautiful piece of embroidered lace.
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Embroidery Supplies
My Lace Maker Software
Water soluble mesh stabilizer
Brother Dream Machine 2

Supplies
Temporary spray adhesive
One pair of jeans
Tulle

Thread
40 wt. embroidery thread
Prewound bobbin

Open a new design in My Lace 
Maker. Open the Lace Design 
folder by selecting the book icon 
on the second toolbar in the upper 
left corner.

Choose the Classic Lace category 
and Design Lace_001.  Click OK.

Save the design.  Save the design 
again in the format for your 
embroidery machine and send it to 
your machine.

Open a new file and open the Lace 
Design folder.  Select Classic Lace 
category, Design Lace_002 and 
click OK.

Save the design and save it again 
in the format for your embroidery 
machine and send it to your 
machine.

At the Machine
Hoop two layers of water soluble 
mesh stabilizer with one layer of 
tulle. Embroider design Lace_001.  
Remove from the machine and set 
aside.

Hoop two layers of water soluble 
mesh stabilizer with one layer 
of tulle and embroider design 
Lace_002.

Trim as much of the water soluble 
mesh without cutting the tulle or 
the lace. Dissolve the water soluble 
mesh stabilizer in a container of 
warm water.

Let the lace dry. After determining 
the best placement of the lace 
to cover the hole, turn the jeans 
inside out. In a well-ventilated 
area, away from your embroidery 
machine, lightly spray the right 
side of the embroidered tulle with 
temporary adhesive spray. Place 
the embroidered tulle right side 
down over the hole in the jeans 
and pin in place.

Continued on Page 78...
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B

B
We recently celebrated a milestone birthday for one of my 
sisters during a weekend visit to Texas. After many texts, 
emails and phone calls, our itinerary was established and 
it was time to get the six sisters and nieces in the same 
town for a girls’ get together. I wanted to give each woman 
in our group a little memento to remember our special 
weekend. The gift had to be embroidered (because that’s 
what I do), affordable, lightweight and small enough to fit in 
my carry-on luggage.

I discovered a simple poem, appropriate for not only the 
sisters, but my nieces as well. The poem was stitched on 
lightweight linen/cotton fabric I had in my stash and placed 
inside a wooden embroidery hoop.

Embroidery Products
Perfect Embroidery Pro software (Freehand font)
Snap Hoop Monster (use size appropriate for your 

project)

Memories to 
Treasure & Keep

    By Marie Zinno
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Supplies
Medium cut away stabilizer
6" wooden embroidery hoops (spring closure) 
Small target ruler, target stickers available in Hoop It Up 

by Marie Zinno and Eileen Roche
Linen or cotton blend fabric: 10" square for each 

embroidered poem

Open a new file in Perfect Embroidery Pro (PEP) 
or similar embroidery lettering program. Select the 
Text tool and type the poem into the Properties Box. 
Choose the Freehand font from the drop-down menu. 

Add a simple scroll frame design to surround the text. 
Go to Text Designs, Monogram Designs and select 
Scroll Frame #43597.

Select the Artwork Tool, Ellipse and draw a 6" circle to 
mimic the wooden hoop you’ll use for displaying the 
poem. 

B
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Resize the design to fit in the circle.  Save the design 
and test it on similar fabric before stitching the final 
project.

Place the wooden embroidery hoop on the fabric.  Use 
a target ruler to find the center and insert a target 
sticker into the ruler’s opening.

To conserve fabric, I wanted to fit all ten designs on 
my yardage. Therefore, I placed each hooping as close 
together as possible, with at least 2" between designs. 

Insert the fabric and stabilizer in the Snap Hoop 
Monster and center the target sticker under the needle. 
Remove the target sticker when aligned. Stitch the 
poem and repeat for as many individual poems are 
needed.

Use the wooden hoop as a guide for cutting the fabric 
around each poem. Hoop the fabric and stabilizer in 
the wooden frame.

Trim all excess fabric and stabilizer, keeping the two 
layers flush with the back of the wooden hoop.
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“I can upgrade any garment 
in my closet with My Lace 

Maker with just a few 
clicks of my mouse!” 

Eileen Roche

Used by embroidery professionals... 

“I have been embellishing 
garments and home dec with 

lace for years, but always 
limited to the embroidery 
designs on hand.  I am so 

excited to collaborate with 
dime in launching my first 

embroidery collection,  A Touch 
of Lace*.  My designs make a 
great start in My Lace Maker 

Software where you can create 
your own custom lace fabric 

and appliques.  This is what we 
call creative freedom!”

Angela Wolf

“Kimberbell Designs is thrilled to collaborate 
with dime for this amazing software debut with 

our own Kimberbell Lace Studio* design CD. 
While each of the Kimberbell lace elements 

may be stitched separately, when imported into 
My Lace Maker software, you have the ability to 

create your own beautiful lace pieces.”

Kim Christopherson
Owner and CEO, Kimberbell Designs

My Lace 

Maker

Includes 

1100+ 
motifs!

No digitizing skills needed! Design your own 
beautiful lace from over 1100 motifs. Plus, all the 

tools you need to transform any embroidery 
design into free standing lace. Select from more 

than 280 shapes, fill them with motifs, add an airy 
grid and column connections.

Specialty Features

Library of 1130 designs
• 52 Bubble
• 216 Classic Lace
• 9 Danglers
• 45 Little Black Tee
• 219 Paisley Borders
• 138 Potpourri
• 61 Sea
• 6 Tassels & Fringe
• 222 Timeless Borders
• 156 Timeless Necklines
• 13 Examples
• Library of 285 Shapes
• 20 built-in Backdrops
• True type fonts
• Customizable lace grid
• Lace grid with border
• Add hole
• Run stitch
• Column connection

Editing Features
• Copy, paste
• Print templates
• Alignment marks
• Group/ungroup
• Combine and break apart
• Change order
• Repeat tool
• Carousel
• Reflect
• Alignment tools

View Features
• Backdrop tool: built in backdrops
• Add your own backdrop
• 3-d view
• Grid
• Hoop view

Drawing Features
• Drawing tools: pen, rectangle, 

ellipse, triangle, diamond, star, 
hexagon, heart, leaf and flower

Minimum System 
Requirements
Windows 7, 1 gigahertz (GHz) or 
faster 64-bit (x64) processor, 1G 
Hard Drive Space, 2 Gigabyte RAM, 
CD or DVD Optical Drive, 800 x 600 
Display, Mouse and Internet Access.

Inspirations Software runs only on 
a PC, not through an emulator. See 
exception to this rule below.

Exception:
Inspirations Software will run on a 
MAC with the use of a MAC Key.

Minimum System 
Requirements:
MacOS 10.10 – Yosemite (64 Bit) 
Processor 1,4 GHz Intel Core i5 
Memory 4 GB Hard Disk 500 GB

DESIGNS IN MACHINE EMBROIDERY
©2019 Designs in Machine Embroidery www.inspiredbydime.com

DESIGNS IN MACHINE EMBROIDERY

Eileen Roche,
Embroidery Expert & Editor of 

Designs in Machine Embroidery

SoftwareSoftware

Plus, all the tools you need 
to transform any embroidery 
design into free standing 
lace!

Design your
own beautiful lace!

116

My Lace 

Maker

Purchase at your local dealer 
or online at www.inspiredbydime.com.

* Designer Collections Sold Separately
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Monogram Cents
                         By Cathy Sundermann

You are your own brand.
And a brand needs a monogram.

From left to right: TOP: Fitzgerald JMC,  Hopping into spring! MIDDLE: The patriotic celebrations are many, Halloween treats or just days 
when you feel a bit batty, BOTTOM:  Turkey Day!, Light up the place for the month of December!
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First choose to use one, two or three of 
your initials.

Just J? JM? Or all three, JMC?

Second, find a font that you like. When 
selecting a font, keep in mind it’s versatility. 
Can the letters be combined in interesting 
ways? Does it lend itself to using more than 
one thread color on a letter? Do the letters 
vary in height and width to add dimension 
to the monogram?

A font that fits all three of those criteria is dime's 
own Fitzgerald. Dime Fitzgerald Alphabet Uppercase 
is set 89. The Alphabet Lowercase is set 90. The font 
has variations in stitch width, straight lines and 
curves, plus areas of crosshatch stitches to add color 
variations.

FREE! Thread Conversion Program plus fully functional software demos! (Save function is disabled)

A 5” x 7” hoop is required to enjoy all designs.Largest designs:  M:  4.39” x 3.75”    Q:  3.72” x 4.57”    W:  4.87” x 3.82”
All other designs will fit 4” x 4” hoop.Includes printable thread color chart and designs provided in the following formats:
C2S, DST, EMD, EXP, HUS, JEF, PES, SHV, VIP, VP3, XXXLetters provided in upper case only. (26 letters, A-Z)

89

Fitzgerald Alphabet
Uppercase

Fitzgerald Alphabet
Uppercase

© 2015 G7 SOLUTIONS, ALL RIGHTS RESERVED

Open your embroidery software and just start 
doodling with the letters you chose. Forget the 
standard monogram rules of placement—this is 
my favorite part! Move the letters around; up, 
down, sideways, every which way, until you find an 
arrangement pleasing to your eye.

My selection contains all three letters; J, M and C. 
The J and M are Fitzgerald lowercase. The C is 
Fitzgerald uppercase. All three letters are placed 
up against each other to look like a continuous 
handwritten initials signature. This is my base 
monogram or brand.

Don’t stop here! Your brand needs a logo. Your 
monogram brand can have a set of variations that 
complement each other and can be utilized for 
different purposes. But how do we do this on a budget? 
That’s the editorial theme of this magazine issue. The 
challenge is to not spend a fortune on embroidering 
something fabulous.

How can this one base monogram 
become a gift set of 10?

And at zero additional cost?

Easy! Search your favorite embroidery design websites 
and see what free designs they offer. Some sites have 
rotating free designs available only for a certain length 
of time, while other sites have a constant free library of 
designs for your use. Remember to test stitch any free 
designs before adding them to your final stitch out. 

The site I used for this budget challenge is 
www.embroiderydesigns.com. They have a 
huge catalog of designs from many designers, 
manufacturers and suppliers. Stitching free designs 
will help you understand the quality and variety 
offered from a site or designer. Read the reviews from 
others who have stitched out the designs. If you are 
pleased with the free designs, I encourage you to 
support them by purchasing designs as well.

Keeping your budget in mind, choose an item to stitch 
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on that doesn’t break the bank. Check out discount 
stores, clearance tables and sales. These linen/cotton 
hemstitch napkins were on a clearance table for the 
very low price of 99¢ each! (Yes, I bought the whole 
stack of them.)

one base monogram + 
bargain napkins + 

free designs =
one stellar gift 
on a budget!

You can have a one-size-fits-all 
monogram, but it’s more fun and 
interesting to have a various, yet similar, 
supply of options to use for different 
occasions. Each one serves a unique 
purpose in how you’re presenting 
yourself.

It’s just embroidery, have fun with it!

Need some caffeine to get started?

Now that’s got your heart racing!

Do you celebrate your birthday for one day? Or declare 
the entire month a celebration?

dime_Volume_117_Body.indd   32 5/15/19   1:28 PM



Designs in Machine Embroidery • Volume 117 • July/August 2019 • www.dzgns.com 33

Headed to the beach or shore for some relaxation?

Or maybe somewhere tropical?
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RAW EDGE 
FEATHER CUSHION 
USING STUNNING SCRAPS

By Holly Nash, Sweet Pea Machine Embroidery Designs
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Save money by reusing scrap pieces of fabric. This raw 
edge feather design is perfect for using many small 
appliqué scraps. The mixture of 14 pieces creates a 
masterpiece, making this design perfect for anyone on a 
budget.  

Do you save all your scraps, but find when it comes 
time to do a project, it’s nearly impossible to find the 
right fabric? Our favorite tip is to keep color-coded 
drawers of scraps; this makes it so much easier to find 
the perfect scraps for nearly every project.

Final Selection

Embroidery Products
Raw edge feather design is available in the 5" x 7",  

6" x 10" or 8" x 12" hoops from  
swpea.com/products/raw-edge-feather

Cut-away stabilizer

Materials
Panel 1 and Panel 3
Fabric A: 8" x 12" background
Small pieces of fabric for the feather appliqué  

– 14 feather pieces per panel

Panel 2
Fabric A: 8" x 12" background
Fabric B: 3" x 4" corners

Batting 1: one 8" x 12" piece for each panel

Cushion
Fabric C: 3" x 12" end borders/flange (cut later - 

measure joined panels first)
Fabric D: 3" x 24" side borders/flange (cut later - 

measure joined panels first)
Fabric E: two 15" x 16" pieces envelope backing 
Batting 2: 3" x 12" end borders (cut later - measure 

joined panels first)
Batting 3: 3" x 24" side borders (cut later - measure 

joined panels first)

Step 1. Embroidery Panels 1 and 3
Hoop cut-away stabilizer and retrieve the design for 
Panel 1 on your machine. The first step, which is 
sewing the batting down and trimming it, is optional. 
When no batting is in the seam, the blocks are easier 
to join. If you prefer the batting in the seam, just skip 
color 1 and proceed straight to color 2. For the first 
step, place batting 1 on top of the hoop and stitch. 
After the step is complete, remove the hoop from the 
machine and trim the batting close to the stitching. 

Note: Place the hoop on a flat surface to trim around 
the stitching. This will provide more stability to trim 
close to the stitching.
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Place fabric A, right side up, in 
the hoop and stitch. Use a colored 
thread or a thread to match the 
background fabric. Next, stitch the 
placement line for the first section 
of the feather. 

Note: The placement lines show 
how big the fabric scrap should 
be. If the fabric is large enough 
to cover all of the placement 
lines then it will be perfect for the 
appliqué.

Cover the placement lines with a 
fabric scrap, right side up. Stitch 
the tackdown.

Remove the hoop from the 
machine and trim the fabric close 
to the stitching without cutting the 
stitching. Use appliqué scissors if 
available.

Repeat the appliqué process with 
the next feather pieces.

Stitch the quilting on the three 
feather pieces.

Repeat the appliqué process for the 
next two feathers.
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Stitch the quilting on one feather 
piece.

Repeat the appliqué process and 
continue the process until all 
feathers and quilting are complete.

Embroider the little feather pieces 
near the bottom and the spine.

Remove the design from the hoop 
and trim the seam allowance to ½".

Embroidery Panel 2
Follow the instructions included 
with the Raw Edge Feather 
Collection to embroider panels 2 
and 3. 

Holly’s Tip
When stitching the quilting, 
use a darker thread for 
the outline to add some 
dimension to the design. 
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Once all the embroidery is 
complete, remove the fabric from 
the hoop and trim the seam 
allowance to ½".

Step 2. Construction
Determine your preferred block 
layout.

Place two blocks right sides together 
and pin.  Sew with a ½" seam 
allowance, just inside the stitched 
border lines.

Continue attaching all your blocks 
in the same manner and press the 
seams open.

Trim the panel if necessary. 
Measure the end of the panels and 
cut fabric C and batting 2 to that 
measurement. Place fabric C on 
top of batting 2 right side up. 

Place one end of the panel on top 
of fabric C and batting 2 wrong 
side up, aligning the raw edges, 
and pin.

Stitch with ½" seam allowance. 
Sew inside the stitched border so 
the stitched line doesn’t show on 
the finished cushion.

Repeat on the other end of the 
cushion.
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Press the borders open and 
topstitch for a neat flat finish.

Trim any excess fabric.

Add the side borders in the same 
way, using fabric D and batting 3.

Cushion Back
Retrieve fabric E sections and 
double fold one of the edges ½" and 
press. Stitch the folded edge. 

Repeat the same steps with the 
other fabric E piece.

Assemble the Cushion
Place the cushion front right side 
up. Take one fabric E piece and 
place it right side down on top of 
the cushion front with the folded 
edge towards the center of the 
front panel.

Place the remaining fabric 
E section right side down, 
overlapping the fabric E sections 
by 2".

The two backing pieces form an 
envelope with the hemmed edges 
overlapping each other. Pin in 
place. Flip the cushion over so the 
wrong side of the cushion front is 
visible.

Stitch with ½" seam allowance 
around the cushion being careful 
not to get the machine foot caught 
on the folds of the backing.

Trim the cushion front and clip the 
corners.

Turn right side out through the 
opening. Use a chopstick to help 
push out the corners. Press. Insert 
a pillow form.
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Embrace the Lace!
By Katherine Artines Part 2

In the 

May/June, Volume 116,  Issue 

of Designs in Machine Embroidery, 

Katherine Artines taught how to create 

the lace embellishments in My Lace 

Maker software. The second part of the 

two-part series illustrates how to 

digitize the in-the-hoop notebook 

cover in Perfect Embroidery Pro. 
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Katherine’s Tip: This double layer of motif is optional, 
but it gives an added design element. Whereas the two 
thread colors I used blend into the fabric, think of the 
"punch" added if you use two highly contrasting threads 
on black fabric!

I recommend buying the notebooks first and making 
the covers to fit those specific notebooks - it’s a 
guaranteed fit that way. Measure your purchased 
notebook.

My notebook measured 8.5" x 12.5". Add 
approximately 1" to the length of this measurement to 
give the notebook some wiggle room inside the cover. 
Create the following pieces in Perfect Embroidery 
Pro in this sequence order. When sizing, remove the 
checkmark from Maintain Aspect Ratio.

Create the double layer of motifs

Placement Rectangle: Artwork / Rectangle, sized to 
13.50" x 8.75"

First Layer, Left Side Motif (red): Artwork / 
Rectangle, sized to 8.4" x 8.75"; Convert to / Complex 
Fill / Motif, Pattern 171, Pattern Length = 35 mm. 
Click the Shape tool and move the Angle lines to 
horizontal. Drag the rectangle to rest just inside the 
original placement rectangle at the left.

Right Side Motif (red): Copy / Paste this red 
rectangle, change the size to 1.6" x 8.75". Drag to rest 
just inside the original placement rectangle at the 
right.

Second Layer, Left Side Motif (green): Copy / Paste 
the red rectangle and change to green. Leave it the 
same, except move the Angle lines to vertical.
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Right Side Motif (green): Copy / Paste this green 
rectangle, change size to 1.6" x 8.75". Drag to rest just 
inside the original placement rectangle at the right.

Appliqué Contrast Column (purple): Select the 
Artwork tool, Rectangle, sized to 3.4" x 8.75", Convert 
to / Run, drag to rest in the empty space between the 
left and right motif rectangles. If needed, adjust the 
width to fit your space. This is the placement line for 
your strip of contrast fabric.

                                                                                                                                                     
 
Appliqué Tackdown Motif (orange): Copy / Paste the 
purple rectangle, Convert to / Complex Fill / Motif, 
Pattern 169, Pattern Length = 30 mm. This fill tacks 
down the appliqué fabric.

Candlewicking Borders: Artwork / Line, draw a line 
on long left edge of the appliqué rectangle. It should 
rest on  thethe rectangle line underneath it so that the 
decorative candlewicking covers the raw edge of the 

appliqué. Convert to / Run / Motif / Candlewicking 1 / 
Pattern length = 15 mm.

Copy and paste the candlewick line, dragging the 
second one to rest on the long right edge of the 
appliqué rectangle.

Cover Flaps: Select Artwork / Rectangle, sized to 
3.5" x 8.75", Convert to / Run / Type = Two Ply. Use the 
Shape tool to split apart at the top and bottom right 
corner and delete the resulting line. You will be left 
with a three-sided line.

Drag it to rest on the left lines of the original 
placement rectangle. Copy / Paste / Flip Horizontal 
/ drag the second one to rest on the right lines of the 
original placement rectangle.
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Lining Tackdown: Artwork / Line / size = 10" 
length / Convert to Run / Type = Two Ply. Drag to 
place centered on top of original Placement rectangle. 
Copy / Paste the line and drag the second one to the 
bottom of the original Placement rectangle.

Finishing Outline Tackdown: Copy / Paste original 
Placement rectangle sized to 13.25" x 8.5". Right click 
the ruler, click Center Origin.

The color sequence should look like the image below:

Fabric Preparation
Focus fabric and Ultra Soft Fusible stabilizer: for each, 

cut one 10" x 14.5" piece. Fuse stabilizer to wrong 
side of fabric.

Appliqué fabric: cut one 4" x 10" piece
Lining fabric: cut one 10" square lining; if desired, 

finish two opposing sides with overcast stitch.
Lining flaps: cut two 7" x 10" flaps, fold and press 

to 3.5" x 10".
Optional: Elastic, cut one 10" length
Optional: Ribbon, cut one 12" length

At The Embroidery Machine
Hoop firm tear-away or no-show mesh stabilizer in 
a 9.5" x 14" hoop. Stitch the placement rectangle on 
the hooped stabilizer. Place Focus fabric/Ultra Soft 
stabilizer to completely cover the rectangle, right side 
up.

Stitch the first layers of both motif rectangles. Change 
thread color and stitch the second layer of overlapping 
motif rectangles.

Stitch the placement guide for appliqué fabric. Place 
appliqué fabric to completely cover the stitch line.

Stitch the motif. Remove the hoop from the machine 
and trim the excess fabric away from stitch line. Stitch 
both candlewicking lines in your choice of thread 
color.

Optional: If elastic is desired as a closure, 
place a piece of decorative elastic right side down 
approximately 1.5" in from the stitch line of the 
narrow motif rectangle on what will be the front cover. 
Tape in place.
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Lay one flap at each end of the notebook cover, 
aligning raw edges with folded ends towards the 
center. Tape in place across the fold. Stitch the two flap 
tackdown stitches.

Optional: If a bookmark is desired, place one raw 
edge of a 12" length of grosgrain ribbon at the top edge 
of what will be the back side of the cover. It is placed 
about 1" away from the folded flap, but make sure it is 
not at the center of the cover when folded.

Tape/Pin in place. Loosely fold the remaining ribbon 
and place it within the flap to avoid catching it in the 
stitching.

Lay the 10" square lining right side down and centered 
on top of the cover/flaps. If you serged two of the edges 
during the prep stage, place the serged edges parallel to 
the flaps. This piece is shorter than the cover to reduce 
the amount of bulk at the corners. You will have about 
1.5" at each end showing the flap.

Tape in place if necessary. Stitch the last remaining 
rectangle to anchor all parts together. Remove from 
the hoop. Trim about 1/4" away from the anchoring 
stitch line. Turn right side out so that the center 
lining is under the flaps, with both the elastic and the 
bookmark free. 
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Insert the notebook.

Decide the placement for the lace letter and added 
embellishment pieces; hot glue in place.

Optional: If you did in a ribbon bookmark, create 
the lace charm. Align the two pieces, wrong sides 
together. With matching thread, sew on the sides 
just inside the satin stitching. Slide the charm up the 
ribbon, deciding how long you want the ribbon tail 
to be. Stitch across the top and bottom of the charm. 
Trim the ribbon below the charm.

Optional: If you added the decorative elastic, it 
should be coming out the front side of the notebook 
and turned to the back to act as a closure.

For inspiring project ideas, visit kimberbelldesigns.com 
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By Kerrin Brookes

It is always nice to receive a handmade gift, and it is even 
better when it is in a lovely gift bag.  This project is exploring 
Premier+™ 2 Extra Enhanced Software.  Create a project in 
the hoop using designs you already own in the PREMIER+ 2 
Extra Enhanced Software manipulating some of the features 
without actually digitizing the project.

Little Treasures Gift Bags
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At the Computer
Open Premier+™ 2 Extra Software. 
Click on the Hoop icon.  The Hoop 
Group should be Universal and 
select a 260mm x 200mm hoop. 
Click on the Super Designs tab. 
Click the down arrow on Category 
and select Buttonholes.

Click the scroll bar on the right 
side and scroll to Buttonholes 3.  
Select the third buttonhole, change 
the size to 18mm and click Apply. 
Right click on Buttonhole and click 
Fix as Stitches. Click on Home tab. 
Click on Cut. 

At the bottom of the screen click 
on Quick Link Modify. Click on 
Paste. Click the View tab and select 
2D View with Stitch Points.  This 
will show the actual stitch points 
to make editing easier.

Click on the Modify tab. Click 
on the Cutwork Line Options.  
Choose Method 2 Cutwork 
Needles and remove the 
checkmarks from all other options. 
Click Ok. Click the down arrow 
on the Cutwork Needle Line and 
choose Freehand Cutwork Needle 
Line. Hold the CTRL key and 
click a point at #1 at the top of 
the buttonhole stitching (not the 
decorative stitching). 

Click on another point at #2 at the 
bottom of the buttonhole. Click 
on another point at #3 at the side 
of the buttonhole.  Click on point 
#3 and move it on top of #1.  Right 
click to complete.

In the Color Select Panel on the 
right side of the hoop, there will 
now be the original pink color, 
plus red and yellow Cutwork 
Needle colors. Click the Home 
tab. Double-click on the Draw 
Next Color Block icon at the lower 
right of the screen. This should 
highlight color 3.  Click the Select 
All icon. Click Delete. Double-
click the yellow Cutwork Needle 
and change it to the Blue Cutwork 
Needle.  Click Ok. Change the 
color of the buttonhole if desired.  

Double-click the Pink color and 
change it to the desired color. 

The cutwork hole needs to be 
stitched first.  On the panel at the 
bottom of the Color Select Panel, 
click the up arrow to move the blue 
to the top of the Color Select Panel. 
Click the File Menu and click 
Save As.  Save as Cutwork Needle 
Buttonhole. Click the File icon and 
click New. This will make another 
tab at the bottom of the screen so 
that there are two active windows. 
Click the Border tab. Click the 
down arrow on the Draw Border 
Line window, scroll  down and 
click #54. Click the Border Shape 
icon. In the Stitch Type field, click 
Running Stitch. Place the cursor in 
the hoop area, one grid from the 
side and two grids from the top.  
Click and drag down to the right 
one grid from the side and one 
grid from the bottom. Click the 
Create External Border icon. Click 
the Home tab. Click the Box Select 
icon on the task bar on the bottom 
of the screen.
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Place the cursor just outside of the top left corner and 
drag about 1/8" down and across the top of the shape to 
the opposite side.  It should encompass the stitching 
across the top of the bag.  Click Delete.

Click on Select Stitches at the top of the screen.  
Click the blue Color Change icon and move it to the 
opposite side of the shape. If the left side of the shape 
is longer than the right side, click the Home tab.  Click 
the Select Stitches icon.  Click the top of the left side 
and drag it down slightly so that it is parallel with the 
center of the Color Change on the right side.

Click the Modify tab. On the Modify Stitch section, 
click Insert Tie On. Then click on the top of the right 
side. Click Insert Tie Off. Then click on the top of the 
left side.  Click the Select All Visible icon. Click on the 
Copy icon.  Click on the Premier+™ 2 Extra icon on the 
Quick Link tool bar at the bottom of the screen. Click 
Paste. Move the bag so that it is at the bottom of the 
screen, but centered on the vertical center line. Click 
the Border tab.

Change the Stitch to a Motif Line. Click the Options 
tab.  Make the Group Pfaff, the Category 4.1 Scallop 
Edges, Pattern 6 and change the Width to 15.9mm.  
Click Ok.

On Motif Underline, click Repeats and make it 12.  
Click on the desktop outside of the bag outline to 
deselect. Click Apply.  Move the box of scallops so 
that they are at the top of the bag and centered on the 
Center Line.  How the scallops fit depends on the size 
of the bag and the size of the scallops.  If the scallops 
don’t quite fit, click the Options icon again and change 
the size up or down by .1 and click Ok.  Keep the set of 
scallops that fit and delete the rest. 
 
Click the Quick Link on the Modify Module.  Click 
the other tab at the bottom of the screen that has the 
buttonhole.  Click the Select All Visible icon. Click the 
Copy icon. 

Click the Premier+™ 2 Extra icon on the Quick Link 
tool bar at the bottom of the screen. Click Paste.  Click 
the Encore tab. On the Layout Section click the Line 
icon and click on Standard Orientation.

Click Preview.  Move the Preview Box up so that it 
is centered on the vertical center line and the upper 
section of the decorative stitching is resting on the 
second horizontal grid line below the scallops. Click 
the white square on the right side of the Encore Box 
and drag it out so that the outer buttonholes are sitting 
on the second vertical grid line from the sides of the 
bag.  Click Apply.

Click the Home tab. Click the down arrow on 
Combine and Combine Selected.  To optimize the 
embroidery, the Cutwork Needles should all stitch at 
the same time and be followed by the buttonholes.

Click the Modify tab. Click the second blue color.  
Click the up arrow and move it under the first blue. 
Click the next blue color and click on the up arrow to 
place it as the third blue.  Continue until all the blue 
colors are together.  Be careful that colors stay in the 
same order so that they stitch in the correct order. 
Merge the colors so there is only one color change. 
Click the last blue color.  Click the Merge icon at the 
bottom of the Color Select Panel.  Continue clicking 
the Merge icon until there is only one blue color. 
Repeat this on the pink color.
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Click the Home tab. Click Select 
All.  On the Layout Section click 
the down arrow on Alignment and 
select Center in Hoop. Click outside 
of the design area to deselect. There 
are three objects in the project.  Press 
the tab key on the keyboard to tab 
until the buttonholes are selected. On 
the Layout Section, click the down 
arrow and select Move to Back.  The 
Cutwork Needles will now stitch first. 
To stitch the buttonholes and the 
scallops the same color, double-click 
on the colors in the Color Select Panel 
and change to a desired color.  Click 
Ok.

Click on the desktop outside of the 
design area to deselect. To see if the 

design stitches out in the correct 
order, click the Play Design icon and 
click Play.  Then click Cancel.

Press the tab key on the keyboard 
to tab until the bag is selected. Click 
Cut and it will place the bag on the 
clipboard at the lower right corner. 
Click File Menu. Click Save As, and 
save as Little Treasures Bag Back.vp4 
and save it to a desired folder. Click  
File Menu and click Export, and 
Export as Little Treasures Bag Back.
vp3.

Click Undo to replace the bag. Click 
the Super Designs tab. Click the down 
arrow on the Category and select 
Effects. In the Super Design Section, 

click the down arrow scroll bar and 
scroll down to Effects. Click Effects 
1 and Design 9.  Change the size to 
90mm.  Click Apply.

Click the Letter Tab. Click Font 
Manager. In the search window, type 
in Curly.  Click Size and change it to 
25.  The font will pop up in a large 
window.  Change Curly 25 to 40.  
Click Close.
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Type the desired letter in the Letter window.  Change 
the size to 40mm.  Click Apply. Click on the Home 
tab. Click on Alignment and click on Center in Hoop. 
If the letter needs to be resized, hold down the CTRL 
key, click on the lower right corner of the Selection Box 
and drag to resize. Click outside of the design area to 
deselect. Press the tab key on the keyboard to tab or 
click on the Next Design icon until the Bag is selected. 
In the Layout Section, click on the down arrow on the 
Layout Order and click on Move to the Front.

To view the stitch out order, click on Play icon and 
click Play.  Click cancel. Click on File Menu and click 
Save As, and save as Little Treasures Gift Bag Front.
vp4. Click on File Menu and click Export, and export 
as Little Treasures Gift Bag Front.vp3, or in the file 
format for your machine.

Supplies
Hoop Size: 200mm x 260mm or larger
Two 13" x 16" pieces of fabric or to fit the hoop (cotton, 

linen or organza)
½ yd. of ½" wide ribbon
Wing Needle
Embroidery 90 needle
Curved embroidery scissors
Wash Away Marker
Sullivan’s Spray Stabilizer or liquid stabilizer
Fray Check
Regular sewing supplies

Prep the Fabric
Spray the fabric with spray stabilizer and press dry 
several times so that the fabric is fairly stiff.

Or paint the fabric with liquid stabilizer (liquified 
Aqua Magic by Inspira®) and let dry. Hoop the 
stiffened fabric.

Download the Little Treasures Gift Bag Back design 
file.

At the Machine
Insert the Blue cutwork needle. Stitch the first 
color. Insert an embroidery needle and thread 
with a matching or contrasting color to stitch the 
buttonholes.

Remove the bag back from the hoop.  Hoop the fabric 
for the bag front. Load the little Treasures Gift Bag 
Front design file. Repeat the above instructions for 
stitching the buttonholes and scallops for the bag 
front.

Insert the wing needle and stitch.  Switch to an 
embroidery needle and stitch the monogram.

Place the bag back, on the hoop, right sides together 
with the monogrammed front section.  Match the 
scallops. Stitch the last color, the piecing of the front 
and back of the bag. 

Run a bead of Fray Check on the back of the scallops 
and press dry with a steam iron.  This will keep the 
scallops soft. Trim the excess fabric from the scallops. 
Soak the fabric to remove the stabilizer, dry and press.  
Insert the ribbon through the buttonholes.

You could customize the bag in any way; use any 
small design; or write the recipient's name, Merry 
Christmas, or Happy Easter.  Other small design 
elements can be found at www.sewspecial.com.  

Enjoy your Little Treasures Gift Bag!
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Inspiration 
Socials • Software & Hooping Clinic • Design Workshop • Stitch Lab • 

• Love Your Lettering from Micro to Maxi Camouflage with Lace •

Find An Event Near You
& Register for an Inspirations Social Today!

Visit inspiredbydime.comfor the most up-to-dateInspiration event listings!

JULY 2019
July 12 - 13, 2019

Hooping Clinic
Ruthie's Notions

Baker, FL

July 12 - 13, 2019
Camouflage with Lace
Sandy’s Fabrics & Machines

Kennewick, WA

July 19 - 20, 2019
Camouflage with Lace

Wish Upon A Quilt
Raleigh, NC

July 26 - 27, 2019
Stitch Lab

Bonnie’s Sewing Center
Bay City, MI

July 26 - 27, 2019
Camouflage with Lace

Sew Much More
Austin, TX

AUGUST 2019
August 2 - 3, 2019

Camouflage with Lace
Quilt Beginnings

Dublin, OH

August 2 - 3, 2019
Camouflage with Lace

Creekside Fabrics, Quilts & Yarns
Arcade, NY

August 2 - 3, 2019
Camouflage with Lace

Sew Many Blessings
Huntington, WV

August 9, 2019
Camouflage with Lace

Rich’s Sewing Vacuum
Albany, OR

August 10, 2019
Camouflage with Lace

Rich’s Sewing Vacuum
Salem, OR

August 16 - 17, 2019
Design Workshop

Ruthie's Notions
Baker, FL

August 16 - 17, 2019
Stitch Lab

Sander's Sew-N-Vac  
& The Fabric Bin
Aberdeen, SD

SEPTEMBER 2019
September 5 - 6, 2019
Camouflage with Lace
Sewing & Vacuum Warehouse

Houston, TX

September 6 - 7, 2019
Camouflage with Lace

All About Sewing
Mobile, AL

September 6 - 7, 2019
Design Workshop

Threads of  Time
Danville, IL

September 7, 2019
Camouflage with Lace
Sewing & Vacuum Warehouse

Conroe, TX

September 13 - 14, 2019
Camouflage with Lace

A-1 Singer Sewing Center
Wichita, KS

September 13 - 14, 2019
Camouflage with Lace

Austin Sewing Machines & 
Quilting

Round Rock, TX

September 13 - 14, 2019
Love Your Lettering

Ruthie's Notions
Baker, FL

September 13 - 14, 2019
Stitch Lab

Ready Set Sew!
Chattanooga, TN

September 19, 2019
Camouflage with Lace
Gall Sewing & Vacuum Center

Lansing, MI

September 20 - 21, 2019
Camouflage with Lace

Richland Sewing Center
Hurst, TX

September 20 - 21, 2019
Camouflage with Lace

Sew n Sew
Appleton, WI

September 21, 2019
Camouflage with Lace
Gall Sewing & Vacuum Center

Grand Rapids, MI

September 27 - 28, 2019
Stitch Lab

Sew Much More
Austin, TX

September 27 - 28, 2019
Camouflage with Lace

Sew Tech
Evansville, IN

Join Us @ These Upcoming Events
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While most embroidery designs are stitched onto fabric, freestanding 
lace refers to the finished embroidery made only with thread. Because of 
the high stitch count, a fabric-like mesh stabilizer provides more support 
for lace embroidery. Once the stabilizer is dissolved, all that remains 
are the threads intricately woven or stitched into lace. The Kimberbell® 
watermelon portraits will be mounted on both fabric for a classy summer 
tote and a metal planter for a sweet succulent garden.
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Embroidery Products
Kimberbell Lace Studio, available 
at your local quilt shop or machine 
dealer

Supplies
Lightweight water soluble fibrous 
stabilizer
Size 75/11 Embroidery needle
40 wt. embroidery thread
Fray Check®
Kimberbell® Blanks Denim Tote or 
Metal Planter
Glue Dots® (for mounting lace)

Properly hooped, water-soluble 
stabilizer can make all the 
difference to a beautifully finished 
piece. At Kimberbell, we hoop 
two layers of fibrous wash-away 
stabilizer for freestanding lace 
projects. Choose a hoop that is 
as close as possible to the actual 
size of the design. Make sure the 
stabilizer is taut in the hoop. 

If freestanding lace will be seen 
from both the front and back, 
like a Christmas ornament for 
example, the bobbin thread should 
match the top thread. Since the 
watermelon portraits featured here 
are being sewn to a background 
or mounted, we chose to keep 
the bobbin color the same as the 
main background through the 
entire stitchout. Use a new 75/11 
embroidery needle and slow the 
machine speed. 

When the embroidery is complete, 
remove the project from the hoop. 
Carefully trim excess stabilizer 
away, leaving about 1/4” of stabilizer 
around the piece. 

Lay the lace piece in water to 
dissolve the stabilizer. Soak for just 
a few seconds or longer, depending 
the flexibility or structure you 
desire. For pliable lace, like the 
watermelon slice sewn to the 
denim tote, allow lace to soak for 
several minutes. The watermelon 
stitched for the succulent planter 
should be firmer for mounting, so 
there is no need to rinse as long.  

 
Tip: Certain wash-away stabilizers 
require warm water to dissolve, 
so it’s important to check the 
manufacturer instructions for the 
recommended water temperature. 
You should also keep in mind 
some bright rayon threads are not 
colorfast in hot water and may 
bleed after soaking for an extended 
time. 

Summe r Wate rmelon
Capture all the delights of warm summer days 

with a delicious slice of watermelon lace
By Kim Christopherson
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Once your freestanding lace has air dried, turn the 
piece to the back and clip bobbin threads. Apply 
generous amounts of Fray Check to any stems, corners, 
thin lines, or delicate areas of stitch work. 

Glue Dots can be used for securely mounting finished 
lace to a rustic metal planter. When sewing the free-
standing piece to fabric, use a needle and thread, to 
take small stitches around the lace to tack in place.   
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Join us for the 2019 quilt-along.  You’ll master piecing 
and quilting in the hoop.  Here’s how it will work. In 
each 2019 issue, you’ll find the instructions for three 
blocks.   You can download the block designs and 
precut files from www.dzgns.com/blog. In addition to 
the downloadable designs, you’ll find a video illustrating 
how to create the block files in My Block Piecer 
and My Quilt Embellisher.  If you have the software 
programs, these videos will help you master creating 
and decorating your own blocks.  If you don’t have the 
software, you can download the files, send them to your 
embroidery machine and stitch the blocks. 

For your convenience, go to the blog,  
www.dzgns.com/blog and search Celebration Quilt  
to access all of the Block of the Month files.  

Finished size: 37" x 46"

Download
Download the FREE downloadable designs 
at www.dzgns.com/blog 

Celebration Quilt 
Block of the Month

By PJ Wong of PJ Designs

Previously Featured 

Blocks 1 - 9
Visit Eileen's Blog,  
dzgns.com/blog,  for 
Blocks 1 - 9.  Search 
Celebration Quilt. 
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Block 10 
Zig Zag Block 
Recommended fabric for 1 Block
Base Block – one 9” square – muslin or No Show Mesh
Back Block - 9” square
Front – all cut parts from Block 10/Cut Files
Warm and Natural or White Batting –
7 7/8” square
 

Block 10 Supplies  

 
1 - Back Block   2 - Bottom Base Muslin 
3 - Top Base No Show Mesh 4 - Batting  
5 - Background   6 - Center
7 - Corners
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Loading the Monster Block 
Maker
Follow the directions included with the 
purchase of Monster Block Maker to 
apply the Maker to a 200mm x 200mm 
Baby Lock/Brother hoop.

Place the muslin flat on the work 
surface. Center the Monster Block 
Maker on the muslin. 1

Insert the batting into the opening of 
the Maker. Place the Top base No Show 
Mesh over the batting. 2

Working from the center out, firmly 
press the No Show Mesh (top) and 
muslin (bottom) onto the adhesive tape 
on the edges of the Maker.

Attach the hoop to the machine. 

Stitching the Block
Stitch color #1, the block layout. Place 
glue at fabric #1 as shown in blue. 3

Place fabric #1, right side up, aligning 
the fabric edge with the stitched outline. 
Stitch color #2, the tackdown. Place glue 
at the seam for fabric #2. 4

Place fabric #2, right side down, aligning 
the raw edges and stitch color #3, the 
seam. Place glue at fabric #2. 5

Flip fabric #2 open and finger press the 
seam. Smooth the fabric and stitch color 
#4, the tackdown. Place glue at the seam 
for fabric #3. 6

Place fabric #3, right side down, and 
stitch color #5, the seam. Place glue at 
fabric #3. 7

 

 

1

2

3

4

5

6

7

8
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Flip fabric #3 open and finger press 
the seam. Smooth the fabric and 
stitch color #6, the tackdown. Place 
glue at the seam of fabric #4.  8

Place fabric #4, right side down, and 
stitch color #7, the seam. Place glue 
at fabric #4. 9

Flip fabric #4 open and finger press 
the seam. Smooth the fabric and 
stitch color #8, the tackdown. Place 
glue at the seam for fabric #5. 10

Place fabric #5, right side down, and 
stitch color #9. Place glue at fabric 
#5. 11

Flip open fabric #5 and finger press 
the seam. Smooth the fabric and 
stitch color #10. 12

Adding the Embellishment
Stitch colors #12, 13, and 14, the 
embellishments. 13

Congratulations, your Zig Zag block 
is complete! 14

 

 

9

10

11

12

13

14
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My inspiration comes from every one of you. In this case, the embroidered tiles by Karen 
Parker, a Certified Ambassador of Education for Baby Lock, caught my eye. Karen chose 
to make hers smaller and with a fill stitch. I began with her tile idea and made it my own 
with larger squares made from raw-edge appliqué shapes which I drew. I also referred back 
to ideas I had learned in a Design Magic class taught by Shelly Stokes of Cedar Canyon 
Textiles concerning positive and negative space.
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Turning 
Tiles
By 
Katherine Artines

Your blocks are together,
Mine are apart.

You call yours a quilt.
I call mine wall art!
Both are beautiful!

Embroidery Supplies
Inspirations Perfect Embroidery Pro software
Baby Lock Solaris Sewing and Embroidery Machine with IQ 

Designer technology

Supplies
6" square wrapped canvas frames
Piece and Stitch tear-away stabilizer
Ultra-Soft Fusible stabilizer
Double-sided fusible web
Assortment of background fabrics
Threads: variety of embroidery threads, metallic threads, 

embroidery bobbin thread
Double-sided peel-and-stick tape or choice of glue
Optional: beads, jewelry findings
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Farmhouse 

Collectio
n

At the Computer 
I use Perfect Embroidery Pro as my drawing program 
to make jpgs for the Baby Lock IQ Designer.

Katherine’s Options:
I needed my square block design as a jpeg file so that I 
could bring it into IQ Designer on my Solaris and add 
some of the new decorative fills. If IQ Designer is not 
available, draw your artwork in Perfect Embroidery 
Pro and convert the outline into a Run/ Bean stitch.  
Add a motif fill to the different shapes.

Each fabric tile will be glued to a 6" square canvas 
so draw a 5.8" square in the software. This smaller 
square leaves a narrow seam allowance for the fabric to 
extend slightly past the stitched outline, covering the 
6" square canvas.

Using the Artwork / Pen too,l draw a shape.

Use the Shape tool to edit points by adding, deleting, 
smoothing, or making a sharp line point. Create each 
shape as its own color. Play with rotating and flipping 
the design both horizontally and vertically to fill the 
tile.

Katherine’s Design Trick:  The trick to having the tiles 
" join" in an overall pattern once placed together is to 
have at least two parts of the design coming from at 
least two sides of the tile.

Copy and paste the tile three times to make a set. 
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Designer and Editor, Eileen Roche has taken a fresh new approach to 
quilting with Farmhouse Beach House. Farmhouse Beach House is a  
16" x 28" printed panel with 8 embroidery designs (sized to fit 5" x 7" hoops).

       
This 16" x 28" panel can be quilted with the 
included wood grain quilting designs and 
embellished with all of the eight embroidery 
designs using the included appliqué fabric.

Once the embroidery and quilting are 
complete, apply the finished project to a 
stretched canvas for a unique wall art that 
measures 12" x 24". Or bind the quilt to make a 
wall hanging.

Farmhouse Beach House includes:
• One 16" x 28" Cotton Panel  

(Includes Appliqué Fabric)
• 8 Downloadable Embroidery Designs  

formatted to fit 5" x 7" Hoop  
Formats: C2S, DST, EXP, HUS,  
      JEF, PES, VIP, VP3, XXX

• PDF templates and color sequences
• Downloadable Instructions

Lake HouseFarmhouse 

Collectio
n

Farmhouse Collection
Lake House

Finished Size: 12” x 24”

Requirements: Windows 7, 1 gigahertz (GHz) or 
faster, 64-bit (x64) processor, 1Gigabyte Hard Drive 
Space, 2 Gigabyte RAM, 800 x 600 Display, Mouse, 
Internet Access and Adobe Acrobat Reader

• One 16” x 28”
Cotton Panel

• 8 Downloadable
Embroidery Designs
formatted to fit
5” x 7” Hoop
Formats: C2S, DST, EXP, HUS, 

     JEF, PES, VIP,  VP3, XXX

• PDF templates and
color sequences

• Downloadable Instructions

www.dzgns.com

ITEM #: FP-LAKEHOUSE

FARMHOUSE_LAKE-PACKAGING.indd   1 3/13/19   4:54 PM

Introducing Lake House

www.dzgns.com
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Adding appliqué fabric can make the overall design 
a positive or negative image. Look at the difference 
between the two images below. 

Here are some ideas I drew. I hope they provide 
inspiration for your own drawings.

The original block outlined in red is a simply drawn 
shape. Notice how the pattern looks if they are left as a 
positive.

The second look is achieved by making two of the 
blocks negative, changing which areas have the dark 
fabric and which have the light.
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Start with a simple shape, such as a butterfly.

Notice how many sides of the butterfly are touching 
the sides of the square.  By rotating and flipping the 
image, you get an interesting tile pattern, while the 
butterfly shape is not initially noticed.

This block is a very easy one to draw.

   
See how different the overall design becomes with a 
unique orientation of each block.

Color can make a difference too. 

dime_Volume_117_Body.indd   65 5/15/19   1:29 PM



Designs in Machine Embroidery • Volume 117 • July/August 2019 • www.dzgns.com66

If you are using multiple shapes within one tile block, 
group them together and play. You can change the 
entire look of the tile pattern by using a different 
corner as the middle. 

You have options as to how you proceed.

Option 1:  Completing the Design in 
Perfect Embroidery Pro
Once all artwork is complete, select them, right click / 
Convert to / Run / set as Bean = 3.5 mm stitch length. 
If you feel you need the placement stitches for each 
shape, make the first set of shapes red and leave as 
a Standard stitch. Copy / Paste the grouped design, 
leaving every shape as a different color to assure a 
color stop, and convert them to the Bean stitch. Save 
the design.

Option 2:  Bringing the JPEG into IQ 
Designer
Once all artwork is complete in PEP, go to File/Save 
As Image.  Name the file and select JPEG for the Save 
As type. Send to your USB. At your machine, touch IQ 
Designer, touch Line Properties / touch Triple Stitch 
and the color red / OK.
Touch Scan key / Line Design / touch the USB, choose 

the proper folder and touch the design / Set / OK / 
Set. Touch Memory to save the shape for future use. 
All lines should be on screen as triple stitch in red. 
Touch the Region (Fill) Properties to choose different 
decorative fills and colors for each shape and section. 
Once each fill is chosen, touch the Region Pour and 
touch within the shape. Each decorative fill is "poured 
on" individually.

Touch Next. Change the stitch settings as desired, 
specifically the size of each decorative fill to be 
appropriate for the size of the area. Use the Set and 
OK buttons to bring the design into Embroidery Edit 
where you can save and embroider the design.  See the 
Embroidery Instruction and Reference Guide if more 
information is needed within IQ Designer.

Embroidery Process
To prepare the fabric, fuse the Ultra Soft stabilizer/
batting to the wrong side of the 7" square of the 
background fabric. Cut the appliqué pieces larger than 
the individual shape and prepare each with double-
sided fusible web. Using a printed template is helpful 
to determine each appliqué piece size necessary for 
each shape.
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Hoop firm tear-away stabilizer with the background 
fabric. Lay each prepared appliqué fabric piece in the 
necessary position with the design stitches out. Trim 
the excess for each appliqué piece before going on to 
the next shape.

 

 

 

 

Stitch two hoopings of the original design. If the 
design you’ve created has a specific shape to give the 
tile blocks an overall "joined" pattern, you may need to 
mirror image the design and stitch two more blocks in 
this orientation. This was necessary for the pink/blue 
tiles. It was not necessary for the gold tiles.

Construction
Once the embroidery is complete for all desired tiles, 
trim each a scant 1/8" away from the stitched square 
outline. Sew on any beading or jewelry findings now. 
Use double-sided tape or glue to adhere each block to 
the canvas. The added black and white stripes on the 
sides of the canvas are washi tape; the polka dots are 
gift wrapping.

Katherine’s Tip:
Here’s my trick to help with hanging these four 
squares evenly spaced on the wall.  Paint a 4" square 
of balsa wood to match your wall color. Lay the blocks 
on a flat surface, right sides down, and measure the 
equal distance apart.  Screw the balsa wood to the 
center back of the squares through the wood of the 
squares.  Adhere the tooth hanger either on point 
or horizontally on the balsa wood—now you are 
really just hanging "one" picture and the balsa wood 
matches your wall color so it doesn’t show!
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Multi-needle
Working with Team Orders

By Marie Zinno

Decorated apparel (embroidery and screen printing) is a $4.5 
billion industry according to marketing trade publications. Most 
likely, you started a commercial embroidery business to get 
a piece of that pie. Owning your own business is a learning 
experience and maybe you have discovered some orders are 
easier than others to produce. There is always a “first” when it 
comes to working on multiples in embroidery. To run a profitable 
business, you need to keep the orders, inventory, supplies and 
quality of your embroidery in check. 

To begin this process, place all new orders in a separate but 
visible area. Use clipboards, clear folders or magazine ra,cks to 
hold the paperwork for upcoming orders. Position those items 
on a vertical space; this will leave your production area clear. I 
never have food or beverages in this area. 

While working on team or other large multiple orders, create 
an Excel form on your computer to keep track of each item. 
Whether team orders are placed through a booster club 
organization, coach, team parent or your business website, 
proper documentation is critical. Payment should be made in full 
at the time the order is placed.

My past experience with the local high school teams has always 
been positive. The team players ordered multiple items. Some 
items were embroidered, and some items were screen-printed. I 
subbed out my screen-printing orders, while making a profit on 
the wholesale items.

For example, the lacrosse team ordered: backpacks, 
sweatshirts, sweatpants, light jackets and long sleeve practice 
shirts for each player. Four out of five items were to be 
embroidered. Each player had their name and team number 
embroidered along with the team logo. There were 40 girls on 
the JV and Varsity teams who placed orders. When you do the 
math, it adds up to 160 profitable pieces to be embroidered. 

10 Tips for 
Working With 
Team Orders

Step 1. Keep the logo as simple as possible. 
You are the embroidery expert; not the 
coach or the 17-year-old team captain. Most 
teams work with a very short time frame  - 
from team selection to the first game. My 
entire window from taking the orders until 
completion was just three weeks. Therefore, 
stitch time should be quick. Try to keep 
all embroidery to one hooping; rehooping 
takes time, and time is money!

Step 2. Make sure the team products will 
be available through the wholesale vendor 
when the orders will be placed. Our school 
colors are purple/white/gold and many 
times the inventory in those colors were low 
to begin with. Call your vendor ahead of 
time if you are concerned.

Step 3. Create a custom Excel sheet for all 
the items to be ordered and embroidered. 
Double-check player numbers, spelling of 
names and sizes.

Step 4. Place the wholesale order with your 
vendor(s). In a perfect world, one vendor 
will have all items, sizes and colors in stock. 
However, this is usually not the norm. Have 
an account with a back-up vendor just in 
case. 

Step 5. Count all items and check the 
materials when they arrive from the 
vendor.  Inspect small details like zippers 
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and buttons. Always refer to the packing list with your 
original order as soon they are delivered. Separate the 
items by size and style in your work area. 

Step 6. Work on one style at a time and prioritize 
the items needed first. For example: the team players 
need a quality backpack to hold their uniforms, 
stick, goggles, cleats and accessories. I usually would 
complete this task as soon as possible. Each team and 
school are different, so double-check with the coach.

Step 7. Stitch items that do not require personalization 
first. The job moves along much quicker if you do not 
have to add a name or number.

Step 8. Create an organized work flow. Unpack all 
items from clear bags and place on a clean counter top 
or table. Use placement tools (Embroiderer’s Helper, 
target stickers, etc.) to have multiple garments ready 
to hoop and stitch. You should have multiple sets of 
hoops per machine. Completed embroidery should 
be placed in another section of the room, ready to be 
trimmed and boxed.

Step 9. Double-check the spelling of all names! 
Re-check the spelling of all names again! Make an 
additional copy in a bold font for your reference while 
stitching. Use a highlighter or other bright marker to 
check off completed names, etc. Each style of garment 
will have the same team logo, but a name or number, 
or both might be added. Make a separate folder of 
names and player numbers, and save it. Insert the 
information as needed per style at your embroidery 
machine.

Step 10. After all embroidery is completed and 
trimmed, place the finished items in a labeled bag for 
each team player.  Ask a parent associated with the 
team to help with distribution at the time of delivery. 
You will have multiple boxes to handle and many bags 
to give each player. Bring the master Excel list and 
check off each name as the bags are delivered.

*To increase your team sales, offer a Spirit Wear collection to 
the families of each player. Some of the profitable and 
easy-to-stitch items I offered were: tote bags, hats, jackets, 
scarves, all-weather fleece blankets and pullovers.
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Let's Play 20 Questions!

By Scott Goodman
Scott Goodman, owner of Sewing Machine Warehouse &  
Kneedle.com has been servicing the sewing public since 1976.
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When I look at a small area within a coral 
reef, I am amazed by the texture, color, 

and detail. Tiny spaces that reveal so 
much more, like embroidery.
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Straight pins have been around for centuries. The concept is 
simple: a thin piece of metal to temporarily hold two materials 
together. Over the ages, there have been great improvements 
on straight pins; however, they leave tiny holes in the material, 
poke fingers and are not ideal for 
on-the-go hand sewing projects.  

About a year ago, sisters Jamie Trinier and Jessica Burch 
developed SewTites. Both ladies are dynamic working moms 
and each have two sons. Dedicated to their families and 
careers, Jamie, an engineer, and Jessica, a business marketer/
graphic designer, still found time to invent a sewing notion 
and start a company.   

SewTites are a way to pin when you can’t! They don't leave 
pin holes and they easily hold thick materials together. 
SewTites come in various shapes and sizes. The original is 
a rectangular two-piece magnet, about 0.5" x 1.5". The top 
piece is teal plastic with three strong magnets embedded in 
the plastic. The bottom piece is a thin piece of metal. SewTites 
now come in a smaller rectangle with a purple plastic with 
two small magnets, 0.75" long called "Minis" and a 0.75" 
orange circle called "Dots". 

These pretty little magnets are the modern method to keep 
materials in place for as long as needed. The sister duo 
originally designed SewTites to hold pockets in place while 
sewing on cork material. Pins were leaving holes and were 
difficult to poke through the materials. Their simple and 

brilliant solution was magnets. This clever invention was 
quickly beloved by the sewers of the world, especially the EPP 
community (English Paper Piecing). Bag lovers have fallen 
madly in love with SewTites and are now joined by machine 
embroidery enthusiasts. The first time I got my hands on a 
set of SewTites I immediately thought of floating material on 
hooped stabilizer. 

Follow a few basic steps to use SewTites:
1. Place the thin metal piece on the bottom.
2. Place the two pieces of material to be sewn on top of the 

thin metal piece.
3. Snap the plastic piece on top.
4. Sew.

When embroidering on a towel the steps are very much the 
same:
1. Hoop stabilizer. 
2. Place the towel over stabilizer on top of the thin metal 

piece.
3. Snap the plastic piece on top (repeat as needed on other 

corners of the towel).
4. Insert hoop and embroider.

SewTites come in several different packs, three to 10 pieces 
per pack, depending on the size and shape. A multi-pack of 
5 of each shape is also available. Prices range between $8-40. 
Learn more at www.sewtites.com. 

SewTitesBy Sue O’Very, Sue O’Very Designs

Does This Notion REALLY Work? 
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Easy Snap Spool!
Experience the premium 
performance of our 40-weight 
polyester Exquisite Thread by 
dime. Perfect for high-speed 
embroidery and color-fast to 
withstand fading. 

Available in 288 colors in 
1M spools with Easy Snap 
Spool bottoms.

• Less Breaks 
• High-Quality 
• Great Value 

Find an Exquisite by dime dealer 
near you at ExquisitePoly.com

by

Stabilizers are 
beautifully 

packaged in 
stay-fresh tubes

• Preserves longevity of specialty 
stabilizers

• Keeps usage instructions with 
the product

• High-quality & Great Value! 

Find an Exquisite by dime dealer 
near you at ExquisitePoly.com
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Evenly-wound
& tangle free

Pre-wound bobbins save time 
No more winding – just load the 
pre-wound bobbin and stitch!

Available in 
Style A/Class 15, 

Style L or Style M

Exquisite® bobbins provide 
consistent bobbin tension 

with lint-free continuous filament 
polyester in either black or white.

Find an Exquisite by dime dealer 
near you at ExquisitePoly.com

Top Quality 
Embroidery

Machine Needles
The unsung hero behind every 
successful embroidery task! 

• Sharp & Ball Point
• Broad range of sizes
• Compatible with  

multi-needle and single needle 
machines. 

Find an Exquisite by dime dealer 
near you at ExquisitePoly.com
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Designs’ Details

www.SewTimeless.com  (877) 870-6961

Use code DIME19 for 20% off all your purchases.

The Completely Amazing

In-the-Hoop

IncludesEmbroidery CDwith over 250Designs!

By Kandi L Christian, MBA

...Continued from Page 27

Select a thread that matches the topstitching on the 
jeans. Slide the pant leg onto the sewing machine.

Use the directional sewing tab to sew the lace in place.

I find it helpful to start sewing straight with a normal 
straight stitch and then change the sewing direction 
as needed to tack down all sides of the lace. Sew in a 
clockwise direction in a shape similar to the hole in 
the jeans. 

Another helpful tip is to keep the needle in the fabric 
while you reposition the jeans. After all sides are sewn 
in place, remove from the sewing machine.  Trim the 
tulle close to the stitching line and turn the jeans right 
side out. 

You have just saved your favorite jeans!
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Buyers Guide
Advertiser Page Website
Amélie Scott Designs  57 www.ameliescott.com

Appliqué for Kids  57 www.appliquéforkids.com

Baby Lock 21 www.babylock.com

BERNINA 3, 5 www.BERNINA.COM/5SERIES

Designs in Machine Embroidery 69 www.dzgns.com

Embrilliance 81 www.embrilliance.com

Embroidery Arts  57 www.embroideryarts.com

Embroidery Designs.com 7 www.embroiderydesigns.com/projects

Embroidery Garden 9 www.embroiderygarden.com

Embroidery Library 80 www.emblibrary.com

Exquisite® by dime 76-77 www.exquisitePoly.com

Graceful Embroidery 53 www.gracefulembroidery.com

Harbor Sales Inc 53 www.ViviLuxUSA.com

Husqvarna Viking 11 www.husqvarnaviking.com

Inspired by dime 55 www.inspiredbydime.com

Janome 41 www.janome.com

My Fabric Designs 1 www.myfabricdesigns.com

My Lace Maker 33 www.inspiredbydime.com

Seams Sew Special 78 www.sewspecial.com

Sew Timeless 78 www.sewtimeless.com

Sweet Pea Machine Embroidery Designs 9 www.swpea.com

Urban Threads IFC www.urbanthreads.com

ZippyDesignZ  57 www.ZippyDesignZ.com

*IFC = Inside Front Cover
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A Peek into the Past
By Eileen Roche

A dazzling white cotton lawn with a hand-rolled hem is the canvas for this elegant and feminine hankie. A blush of pink, a 
splash of blue and a flowing stream of gray moves the eye from the monogram to the bed of delicate flowers. Balanced but 
not symmetrical, the embroidery splays across the corner, setting the stage for the oversized single-letter monogram.  Upon 
closer inspection, each element is a work of art.  The shrimp-colored  J  is a corded-satin column bordered with a line of 
tiny running stitches.  Inside, pairs and trios of small French Knots fill the open spaces.  

It’s inconceivable to me that the microscopic stitches of each element in the floral spray were done by hand.  They are so 
tiny, so itty-bitty, I can just imagine the delicate hands that laid down each stitch.  The work is uniform as the stitch widths 
and lengths are even throughout the whole piece. Even the back is beautiful as the tie-offs (knots) are invisible. 

Who stitched this?  Who carried this treasure? Is the letter  J  for a first name? In the 1920s, the three most popular girl’s 
names with the letter  J  were Jean, Josephine and June. One can only imagine where Jean, Josephine or June carried this 
hankie as its pristine condition tells us it has been tenderly cared for and used.  Was she a city slicker or a country girl? A 
world traveler or homebody?  So many questions…
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“Satisfaction Guaranteed!
You won’t know how you lived without it!”

-Brian Bailie

www.Embrilliance.com

Mac and Windows versions
are included with our software

– This Issue’s Inside Look –

EmbrillianceEmbrilliance
Embroidery For the Rest Of Us!

TM

Embrilliance Essentials

Essentials is so EASY - do more sewing
 spend less time at the computer!

• Merge designs, Remove overlaps
• Re-Size, recalculate
• Change threads
• Edit sections
• Convert formats
• Browse, even in .ZIPs
• Letter, 12 built-in fonts
• Multi-line,Circle text
• Monograms, with layouts
• Built-in designs
• Project Advisor
• Split for Multi-Position Hoops
• Sew Simulator, Printing and More!

Create stunning compositions!

StitchArtist
TM

Creating Designs just got easier 
(and a whole lot less expensive!)

Only$379!

Level 1
Only

$169!

“Yes, we know other software costs thousands. 
How do we do it?  We sell a lot more because 
people actually use our products. 
 -- It’s a simple formula, and it works.”  

In celebration, use this coupon code for 
10% o� your purchase. Expires 8/31/19

Code: DIMEREG2019

Visit our facebook page and see why we are the best ‘liked’ embroidery software in the world.

Only
$149.95

Level 2

A Super Value!
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